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1 Resolving Problems

This section helps you with:

1.1 - Resolving installation problems
1.2 - Resolving software problems
1.3 - Resolving CNC communication problems

1.1 Resolving Installation Problems

If you encounter a problem while installing the Dostek DNC software:

Write down, print or save a screen image of every error message
(see Section 4 below: Send Screen Image to Dostek).

To install the software, log on to your computer using an account
with administrator privileges.

Ensure that all other Windows applications are closed before starting
the installation. 

Carefully read and follow all messages and instructions displayed on
your computer screen during installation. 

Fully complete the Dostek DNC First-Time Setup Wizard. It starts
automatically when the software installation is completed. 

Try installing Dostek DNC on a different computer. There may be a
problem with your computer. Windows computers can become
unstable over time due to viruses, spyware, registry corruption,
installation of non-compliant applications, and so on.  

1.2 Resolving Software Problems

If you encounter a problem when you start the Dostek DNC software or
perform a specific task:

Write down, print or save a screen image of every error message
(see Section 4 below: Send Screen Image to Dostek).

Write down exactly what you were attempting to do when the
problem occurred, including the commands or key sequences you
pressed.

Restart the computer and try again. Windows computers can become
unstable or low on resources.

Ensure the computer's disk drive is not full.

If you are attempting to access files on a network resource, ensure
the network is working properly and you have sufficient network
privileges.

         

 Support Procedures Page 2 

 DOSTEKToll free 1-888-355-5735
www.dostek.com



1.3 Resolving CNC Communication Problems

If you encounter a problem when you upload, download or drip feed:

Write down, print or save a screen image of every error message
(see Section 4 below: Send Screen Image to Dostek) displayed by
the software or by the CNC.

If the CNC displays an alarm, also find the alarm description in the
CNC manual and write it down or make a copy of the manual page.

Use the sample device configuration provided for your CNC, and
carefully read the notes provided in the "Notes" tab. To use a sample
configuration:

a) Start the Dostek DNC Configuration application.
b) On the File menu, click Import sample configuration.
c) Click the Notes tab and read the comments and instructions.

Keep notes. Before you change anything (on the computer or the
CNC), write down the current setting, the new setting, and the
reason for the change.

Read Section 5.2, Testing Communication, in the Dostek DNC
Configuration Guide for information about detailed test procedures.

View the Communication Testing and Troubleshooting help file
(Navigator Help tab, or Dostek DNC Help menu) for detailed
recommendations for typical communication problems. Go to the
'Problem Topics' section and find the topic heading that most closely
describes your problem.

2 Sending Information to Dostek

This section helps you with:

2.1 - Sending screen images
2.2 - Sending files
2.3 - Sending captured CNC output
2.4 - Sending component version information
2.5 - Sending BTR configuration

2.1 Sending Screen Images

To capture a screen image (such as an error message) and send it to Dostek:

1. Press the computer's PrtScrn key. A snapshot of the current screen
image is saved to the Windows Clipboard.

Note: To save a snapshot of only the current window (not the entire
screen), press Alt+PrtScrn.

2. On the Windows Start menu, click Run.  The Run dialog box
appears.

3. Type MSPAINT and then press Enter. The Windows graphic
editor window opens.
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4. Press Ctrl+V. The captured screen snapshot is pasted into
Windows Paint. 

5. On the File menu, click Save as. The Save As dialog box
appears:

a) Select a file location using Save in. [1]
b) Type a file name in the File name box. [2]
c) Select 'JPEG' in Save as type (to minimize file size). [3]
d) Click Save. The file is saved. [4] 

6. On the File menu, click Send. A new message is opened in the
computer's email client. Type 'support@dostek.com' in the To
box.

Note: If an email client is not installed, see Section 5, "Sending Files to
Dostek."
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2.2 Sending Files

This section explains how to send files to Dostek, including:

v Dostek DNC configuration files
v Dostek DNC log files
v Data files
v Dostek MultiPort DNC messages
v Dostek MultiPort DNC received file
v Dostek MultiPort DNC feedback message file

To send files to Dostek, attach the files to an email message addressed to
"support@dostek.com".

If your computer does not have an email client installed, copy the files to
another computer using a USB memory device, a removable disk, or a shared
network folder.

Sending Dostek DNC Configuration Files

To send Dostek DNC configuration files to Dostek:

1. Start the Dostek DNC Configuration application.

2. On the File menu, point to Explore and then click Dostek
DNC\Settings. A new Windows Explorer window opens in the
Dostek DNC "Settings" folder.

3. Select one or more files, or press Ctrl+A to select all files.

4. On the Explorer File menu, point to Send and then click Mail
Recipient. A new email message is opened, with the selected
files attached.

Note: If the computer does not have an email client installed, on the
Explorer menu click Edit, Copy to folder and browse to select a
network folder or removable media on which to store the files.

Sending Dostek DNC Log Files

To send Dostek DNC log files to Dostek, follow the same procedure as the
previous section, except click Dostek DNC\Log in step #2.   
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Sending Data Files

To send data files to Dostek:

1. Right-click the Windows Start button, and then click Explore in
the context menu. A new Windows Explorer window opens.

2. Browse to the folder containing the data files you wish to send.

3. Select one or more data files.

4. On the Explorer File menu, point to Send and then click Mail
Recipient. A new email message is opened, with the selected
files attached.

Note: If the computer does not have an email client installed, on the
Explorer menu click Edit, Copy to folder and browse to select a
network folder or removable media on which to store the files.

Note: If you are sending a large number of files, or files that are very
large, use WinZip (or similar) file compression software to condense and
combine the files into a single file.

Sending Dostek MultiPort DNC Messages

To send Dostek MultiPort DNC message and log files:

1. From the Dostek MultiPort DNC server application (DMDNC32)
menu, click Help, Copy messages to clipboard. All recent
messages are copied to the Windows Clipboard. 

2. Open a new email message, and then paste the messages from
the Windows Clipboard into the message.

Note: If the computer does not have an email client installed, open a
new Notepad or Word document and then paste the messages into the
new document. Save the document to a file, and copy the file to another
computer using a removable disk or shared network folder.

Note: To send recent messages for one specific CNC only:

a) Select the CNC in the DMDNC32 application's CNC list.
b) On the menu, click Channel, point to View and then click

Messages.          
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Sending Dostek MultiPort DNC Received File

To send the content of the most recently received file for a specific CNC: 

1. Select the CNC in the DMDNC32 application's CNC list.

2. On the menu, click Channel, point to View and then click Last
received file. The most recently received file is displayed in the
view window. 

3. Open a new email message, and then paste the messages from
the Windows Clipboard into the message.

Note: If the computer does not have an email client installed, open a
new Notepad or Word document and then paste the messages into the
new document. Save the document to a file, and copy the file to another
computer using a removable disk or shared network folder.

Sending Dostek MultiPort DNC Feedback Message File

To send the most recent feedback message sent by the Dostek MultiPort DNC
software to a specific CNC:

1. On the DMDNC32 menu, click Tools, and then point to Explore,
and then click Dostek DNC\Log. A new Windows Explorer
window opens in the Dostek DNC Log folder.

2. Select the .fbk file (file with extension '.fbk') matching the name
of the CNC.

3. On the Explorer File menu, point to Send and then click Mail
Recipient. A new email message is opened, with the selected file
attached.

Note: If the computer does not have an email client installed, on the
Explorer menu click Edit, Copy to folder and browse to select a
network folder or removable media on which to store the files.
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2.3 Sending Captured CNC Output

This section explains how to:

v Capture data sent from the CNC to the computer using the Dostek DNC
Com Test Terminal application (DTerm32).

v Send the captured data to Dostek.

To capture data sent by the CNC and send it to Dostek:

1. Start the Dostek DNC Com Test Terminal application (DTerm32):

a) If you are using the Dostek DNC File Manager (DDFM32), on
the Supervisor menu, click Com Test Terminal. 

b) If you are using the Dostek DNC MultiPort server (DMDNC32),
on the Tools menu, click Com Test Terminal. Note: You
must first "disconnect" the channel as explained in Appendix A,
"Disconnecting a MultiPort DNC Channel."

The DTerm32 Device Configuration window opens. 

2. Select the configuration for the CNC you wish to receive data
from, and then click OK. 

3. An additional information message may appear. Click OK. The
DTerm32 window opens with the title "COMn - DTerm32 - Dostek
DNC Com Test Terminal" (where 'COMn' is the selected COM
port).

Note: The status panel at the bottom left corner of the window should
indicate 'Connected' on a green background. If the status indicates
'Disconnected' on a red background, DTerm32 was unable to open the
COM port. This could mean the port is already in use by another applica-
tion, or the port is not configured properly.
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4. Configure the DTerm32 'Options' menu as shown below, and set
the 'Flow Control' setting in the toolbar to 'None'.

5. On the DTerm32 menu, click File, and then Capture to log file.
The "Open communication log file" window opens.

6. Select an existing log file, or type the name of a new log file, and
then click OK.

Note: Use the extension .log or .txt for the log file. This makes it easier
to open the file in a text editor or attach it to an email message.

7. Go to the CNC and send the data you wish to capture. Captured
data scrolls in the DTerm32 window, and will usually appear
something like the example below: 

Note: Control characters (such as 'Line Feed') that are not
normally visible are displayed as a two-character 'control-code'
sequence. For example, the NULL character which is used by
some CNCs to produce blank tape on a paper tape punch is
displayed as '^@', and the LF (Line Feed) character designated as
the 'End of Block' code in ISO-standard G-code programs is
displayed as '^J'. 

8. On the DTerm32 menu, click File, and then Capture to log file
again to stop capturing data. The "End capture" prompt appears.
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9. Click a button to choose what to do with the captured data. To
send the captured data to Dostek by email:

a) Click Clipboard to copy the captured data to the Windows
clipboard.

b) Open a new email message, and then paste the captured data
into the email message.

Note: If the computer does not have an email client installed, save the
copy the captured file to another computer by a removable drive or a
shared network folder.

2.4 Sending Component Version Information

Dostek DNC includes an application that reports the current version of all the
software components it uses.

To send a software component version information to Dostek:

1. Start the Dostek DNC Navigator application.

2. Select the Navigator's Test tab, and then click Version
Information. The Component Version Info window opens. It
displays a list of all software components and the current version
of each.

Note: If Version Information is not visible in the Test tab, start the
component version application manually:

a) Open Windows Explorer.
b) Browse to the "C:\Dostek DNC" folder.
c) Locate and double-click the "DComponentVersionInfo"

application.

3. In the Component Version Info window, click Copy to Clipboard.
The version information is copied to the Windows Clipboard.

4. Open a new email message, and then paste the captured data
into the email message.

Note: If the computer does not have an email client installed, save the
copy the captured file to another computer by a removable drive or a
shared network folder.
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2.5 Sending BTR Configuration

The Dostek DNC Com Test Terminal application includes a feature to capture
configuration information from a Dostek Model 440A Behind-the-Tape Reader
(BTR).

To send 440A BTR configuration information to Dostek:

1. Ensure the 440A BTR is not already in use. The BTR's 7-segment
indicator should display any one of the following three symbols: 

2. From the DTerm32 menu, click BTR440A, and then Query.
(Requires DTerm32 version 2006.22A or later).  

DTerm32 sends a series of commands to the 440A BTR to capture the
configuration information. The BTR will indicate 'C' (command mode) for
a few seconds during this process. The Results window opens with a list
of the BTR configuration information. 

Note: To download the latest version of the DTerm32 application, visit
www.dostek.com/support.htm and click the Support Update link.

3. Click Copy results to Windows Clipboard. The results are
copied to the Windows Clipboard.

4. Open a new email message, and then paste the captured data
into the email message.

Note: If the computer does not have an email client installed, save the
copy the captured file to another computer by a removable drive or a
shared network folder.
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3 Support Tips

Following these tips will help you obtain fast and accurate technical support
from Dostek.

v Review the recommendations for resolving problems provided in
Section 1.

v Write down your observations, including all alarm codes and error
messages, and a brief description of exactly what you were doing
when the problem occurred. 

v When describing a problem (verbally or in writing), be specific and
avoid the use of slang and ambiguous terminology. For example,
instead of saying "When I'm downloading, the CNC crashes and the
computer stops", say "When I'm sending a file from the computer to
the CNC, the CNC indicates alarm 86 and the Dostek DNC software
stops after sending 14 percent of the file and displays the message
"XOff char received."

v Whether you contact Dostek by telephone, fax or email, be sure to
provide your complete contact information including:

v Your full name
v Your company name (required to locate your file)
v Your telephone number, including area code
v Your correct email address
v Your Dostek DNC software version number (start Dostek DNC

Navigator, and click the About tab)

Note:

Telephone technical support is free during the free trial period and to regis-
tered users for a limited time after purchase. Thereafter, telephone support
may be subject to a reasonable fee. Please contact Dostek for more
information.

Email support is always free to registered users, subject to reasonable limita-
tions. 

www.dostek.com/support.htmInternet

519-741-8669Facsimile

888-355-5735 (Toll free, USA and Canada)
519-742-5721
8am - 5pm EST, Monday to Friday

Telephone

support@dostek.comEmail
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Appendix A - Disconnecting a MultiPort DNC Channel

This appendix explains how to disconnect a Dostek MultiPort DNC channel so
you can capture received data using the Com Test Terminal (DTerm32)
application.

Capturing data received from the CNC is explained in Section 6, "Send
Captured CNC Output to Dostek."

When you are using the Dostek DNC MultiPort server application (DMDNC32),
you must "disconnect" the CNC channel before you can capture data using
DTerm32.

To disconnect the CNC channel:

1. Select the CNC whose data you will be capturing in the MultiPort
DNC channel list: The selected channel is highlighted.

2. On the DMDNC32 menu, click Channel, and then Disconnect.
The channel's COM port is released (closed) so the port can be
opened by the DTerm32 application.
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